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Executive Summary 

This deliverable contains the User Manual of the MOBILO System. Mobilo system is 

consisted of three main software components and one integrated system that contains 

several components and is presented in D20. Specifically, the software components that are 

developed during the project’s evolution are, the Calibration software, the Data collection 

software, and the Data processing software. In this deliverable, we will provide user manual 

for each one of the applications. Moreover, regarding data collection software we hereafter 

provide the tasks that are needed to be performed on – site for system initialization and give 

the details about the collected data and how they must be managed to be used by our 

system. 
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1 Introduction 
This deliverable contains the User Manual of the MOBILO System. Mobilo system is 

consisted of three main software components and one system presented in [D20]. 

Specifically, the software components that are developed during the project’s evolution are: 

 Calibration software 

 Data collection software 

 Data processing software 

As such, in the following section we will provide user manual for each one of the 

applications. Moreover, regarding data collection software we hereafter provide the tasks 

that are needed to be performed on – site for system initialization. The structure of the rest 

of the document is as follows: Section 2 provides the manual of MobiloCalibration 

application used for system calibration. Section 3 provides the on-site system’s setup and 

remarks about system initialization. Section 4 gives the interface of SharpLabelImage 

application developed for image tagging purposes, while Section 5 describes the usage of 

Mobilo data processing software which is the main user environment. 

2 MobiloCallibration Application 
The tool is written in C# and uses Windows Forms as its graphical interface developed with 

Windows Forms, and .Net Framework 4.5. 

2.1 GUI MobiloCalibration Overview 

Mobilo Calibration is a graphical camera and camera rig calibration tool using images 

captured by the Mobilo mobile mapping system. The images should contain a chessboard of 

known dimensions for the tool to be able to perform the calibration. It needs to be specified 

that the chessboard needs to cover most of the frame. Software usage and remarks. Besides 

its camera calibration capabilities, Mobilo Calibration tool has two other major 

functionalities that can be executed after the calibration process: 

a) Spatial Resection [1]: This feature allows the user to perform spatial resection to an 

image in order to estimate the exterior orientation parameters. 

b) Spatial Intersection [1]: This feature allows the user to perform spatial intersection 

on a stereo pair in order to receive the 3D coordinates of points in the stereo pair. 

The former is used to calculate the boresight misalignment between the imaging and the 

positioning subsystems of MOBILO. Spatial intersection module is used for testing purposes 

so as to test the calculations of the stereo rig. 

2.2 CalibrationProtocol 

Mobilo’s imaging subsystem calibration is consisted of the interior (single camera 

calibration) and relative orientations between the cameras. (stereo rig calibration).  

For the single camera and stereo rig calibration the user needs to acquire stereo pairs of a 

calibration checkboard of known dimensions. The calibration dataset must consist of 8*5 

stereopairs. More specifically the user starts capturing images of the checkboard while 
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another person rotates it each time by 45 degrees. This process is repeated 5 times, 1 with 

the checkboard being parallel to the camera plane, 1 with the checkboard being leaned 

forward, backwards, left, and right. In total there need to be 40 stereo pairs captured for the 

calibration to be as accurate as possible.  Additionally, the users must ensure that the 

checkboard covers as much of the images as possible in every capture. The methodology 

that is used for interior and stereorig calibration is described in [2]. 

2.3 Single Camera Calibration 

Figure 1 depicts the main window and interface of the first and main feature which is the 

camera and rig calibration. Here the user can perform single camera calibration and camera 

rig calibration.  

A. The user must insert the number of crosses (not the number of cells) on the 

checkboard in both directions as well as the cell size. 

B. The user loads the images from either the left or the right camera. 

C. The tool finds the points and their image coordinates on the crosses in each image. 

D. The tool performs the camera calibration and estimates the parameters of the 

camera’s interior orientation and then allows the user to save them in an .int file 

which later can be used in the camera rig calibration, resection and intersection. 

E. Saves the points and their image coordinates. 

 

Figure 1: Main Interface of single camera calibration 

2.4 StereoRig Calibration 

Figure 2 depicts the main window and interface of the first and main feature which is the 

camera and rig calibration. Here the user can perform single camera calibration and camera 

rig calibration.  

A 

B 
C D 
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A. The user must insert the number of crosses (not the number of cells) on the 

checkboard in both directions as well as the cell size. 

B. The user loads the images stereo pairs. The image names should end in L.png. 

Meaning that we select the images of the left camera and the system automatically 

can load also the right image based on the names. As an example, we have the pair 

1_L.png and 1_R.png 

C. The user must load the interior orientation of the left image that was estimated with 

the single camera calibration step. 

D. Respectively like the above step, the user loads the interior orientation for the right 

camera. 

E. Finds the points and their image coordinates. 

F. The tool performs the camera ring calibration and estimates the parameters and 

then allows the user to save them in an .ring file which later can be used in the 

intersection 

 

 

Figure 2: Main Interface of camera rig calibration 

2.5 Spatial Resection Module 

The below picture (Figure 3) depicts the interface of the second feature which is the spatial 

resection. Here the user can perform Spatial Resection for the estimation of the exterior 

orientation parameters of an image. 

A 

B C DE F
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Figure 3: Main Interface of spatial resection feature 

A. The user must load the interior orientation of the camera (e.g. left). 

B. The user must load the image captured by that particular camera (e.g. left). 

C. The user must load the list of GCPs and their 3D space coordinates. 

D. When the user loads interior orientation, the image and the GCPs, then they must 

place at least 6 points on their proper position in the image (red flags). That can be 

done by right clicking on the point in the image and select place point. After that the 

list of GCPs pops up and the user choses the right point.  

E. After the user has placed enough points on the image, then they can perform spatial 

resection with 2 ways. The first one is via Computer Vision Algorithms. 

F. The second one is via Photogrammetric Algorithms and the Collinearity equation. 

G. The user can also save the points with their image and 3D coordinates. 

H. Here the user can see the total RMS error of the Spatial Resection. It is 

recommended that this error should be less than 1 pixel. If that is not the case, the 

user should check if the measurements on the image are correct (the points are 

placed correctly), include or exclude points from the solution based on their 

individual errors.  
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2.6 Spatial Intersection 

The below picture (Figure 4) depicts the interface of the third feature which is the spatial 

intersection. Here the user can perform Spatial Intersection on a stereopair captured by the 

Mobilo Mobile Mapping System and acquire the 3D coordinates of homologous points that 

are present in both images, draw lines and measure 3D distances. 

 

Figure 4: Main Interface of the spatial intersection feature 

A. The user must load the calibration parameters of the camera rig. 

B. The user must load the exterior orientation of the left image. 

C. The user must load the stereo model. 

D. The user can place points, measure distances, or draw lines in one image and the 

tool projects them in the other image while is calculating the distance of the line or 

the 3D coordinates of the point.  

E. The user can save all the measurements. 

F. The user can place labels. 

3 MOBILO Mobile Surveyor Data Acquisition Overview 
MOBILO Mobile Surveyor is a low-cost mobile mapping system. It utilizes various sensors like 

GNSS/INS and machine vision cameras for data acquisition. The system captures stereopair 

images as well as the trajectory of the vehicle and since the system is calibrated, allows the 

user to extract various 3D information. The data acquisition and preparation processes are 

very simple and it will be described in this document step by step.  

A 
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3.1 The system and its components 

Figure 5 shows the system as a whole, mounted on the top of a car using 2 magnetic bases, 

where Figure 6 depicts the various components of the system. 

 

Figure 5: The complete system mounted on top of a car. 

Figure 6 illustrates all system components arranged in the MOBILO carrier. 

A. High accuracy – low cost GNSS sensor U-blox ZED-F9P module. 

B. Low-cost INS sensor Xsens MTi-7. 

C. Antenna Splitter. 

D. Unified Antenna exit. 

E. FLIR Blackfly S Color 5.0 MP USB3 Vision (Sony IMX250) Camera 1. 

F. FLIR Blackfly S Color 5.0 MP USB3 Vision (Sony IMX250) Camera 2. 

G. Camera Lens. 

H. USB 3.0 Hub. All the components are connected with a laptop through the 

hub. 

I. Laptop connector. 

J. Power Bank 25000mAh. It powers up the system and it allows the duration of 

data acquisition to be up to 7 hours. 

K. TW7872 GPS L1/L2, GLONASS G1/G2, BeiDou B1, Galileo E1 Antenna, 

Magnetic Mount, 32dB Gain, Dual Feed. 
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Figure 6 : All the components of the system arranged in the carrier 

3.2 Setup and data gathering procedure 

3.2.1 Placement of the system on top of the vehicle  

First the system needs to be placed by 2 persons ideally as the image of Figure 7 shows: 

 

Figure 7: Placement of the system 
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After placing the system, we need to connect it with an on-board Laptop (Figure 8). 

 

Figure 8: Connecting the system to a Laptop 

3.2.2 System Initialization 

This procedure is very specific, and the proper implementation ensures that the system 

operates properly. 

 

Figure 9 :Placement of the antenna at position 1 of the carrier 

 The system is connected to the internet either through a mobile phone hotspot or a 

sim card directly through the computer. 

 Following that the system connects with the GPS/INS subsystems. 

 Before any positions are recorded, a connection with a GPS positions provider like 

Cypos, must be established. 
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 The system allows import of providers and their info. 

Next the antenna is placed at position 1 (Figure 9) on the carrier and we measure a fix 

position in various epochs by the respective button the GUI. 

After that we repeat the previous step for position 2 on the carrier. 

Then we place the antenna at a random but stable position at the back of the vehicle (Figure 

10) where we also measure the fix position on various epochs. The antenna should stay 

there for the duration of data acquisition. 

 

Figure 10: Placement of the antenna at a random position 

If the antenna and the carrier remain in these positions, the above steps do not need to be 

repeated in the event of a system shutdown. 

3.2.3 Camera system activation 

After the initialization step, we activate the cameras from the USB Hub (Figure 11), and we 

check that the cameras record in real time in the GUI. This is shown at the right of the 

computer screen after selecting preview cameras (Figure 12). 
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Figure 11: Camera activation 

 

Figure 12: Real time recording check at the right of the computer screen. 

3.2.4 Start recording the route and data recording 

After we ensure that all the previous steps were done successfully, we are now able to start 

the data gathering and recording. The system records the route and stereo images in real 

time (Figure 13). Additionally, it shows to the user in real time what the cameras see (right of 

the screen) but also it shows the vehicle’s route on an overlayed base map (Centre of the 

screen). Also, the user can check if the system records float or fixed positions as is shown by 

a Fix or Float indicator at the left of the screen. 
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Figure 13: Real time data gathering and recording from the system. 

3.2.5 Closing the system 

After the data gathering and recording is done, the power is switched off from the power 

bank and the system is detached from the car (Figure 14). 

 

Figure 14: System detachment from the vehicle. 

3.3 Result Data  

All files are gathered by the previous procedure are stored in a folder that serves as a 

project, in our API. The folder where the recording occurs contains several files that are 

divided into the following categories: 

 Files depended on the MOBILO system’s setup (Table 1) 

 Files containing the actual data collected during on-site data collection (Table 2) 
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These files are illustrated in the following tables. Regarding the notation used, [DateInfo] 

denotes a string in the form of YYYY-MM-dd_HH-mm-ss, e.g., 2021–03–31_09-30-00, while 

[NNNN] denotes a serial number starting spanning from 0 to 9999, i.e., 0000, 0001, 0002 etc. 

Each project stands for a single MOBILO system’s setup and may contain data collected at 

several time periods (as long as the system setup has not been changed). 

Filename Description 

YawFix.txt Contains information regarding the heading alignment procedure 

(i.e., the δheading value in degrees). If file is absent, e.g., before heading 

calibration, δheading is assumed to be zero. 

[DateInfo]-

cmdGetPosition1.txt 

Contains measurement information about the initial position 

obtained by our GPS / GNSS in MOBILO’s system position 1 

[DateInfo]-

cmdGetPosition2.txt 

Contains measurement information about the initial position 

obtained by our GPS / GNSS in MOBILO’s system position 2 

[DateInfo]-

cmdGetDetachedPosition.txt 

Contains measurement information about the initial position 

obtained by our GPS / GNSS in MOBILO’s system position 1 

Table 1: Project Files depended on the MOBILO system’s setup. 

The following Table 2 contains a description about all files gathered during a MOBILO 

collection process. MOBILO’s project may contain data from several such collections. 

Therefore, a project folder may contain several file groups that comply with the description 

of Table 2; an example of these data groups is illustrated in Figure 15 displaying the contents 

of a MOBILO project that is composed by two separate collection processes, i.e., collection 

process that started at 2020-07-26 11:54:43, and collection process that started at 2020-07-

26 11:55:36. 

Filename Description 

[DateInfo].txt Contains date/time information regarding the video that was started 

at the [DateInfo] timestamp. 

[DateInfo]-L-[NNNN].avi The n’th video file of the left camera that was started at the 

[DateInfo] timestamp. It should be noted that FLIR’s API that is used 

to produce avi files divides collected video files up to a size of 2GB. 

For example, in the case where a video collection procedure lasts 

several hours without stopping it, thus producing avi files up to 10 

GB, 5 files will be produced denoted with the name [DateInfo]-L-

0000.avi, [DateInfo]-L-0001, …., [DateInfo]-L-0005. 

[DateInfo]-R-[NNNN].avi Same as previous regarding the right camera. 

[DateInfo]-gps.trj Contains trajectory information obtained by GPS/GNSS regarding the 

data collection process that was started at timestamp denoted by 

[DateInfo]. Specifically, it contains GPS/GNSS position measurements 

obtained by Ublox F9P, along with datetime, fix status and achieved 

precisions. Data are logged in WGS84. 

[DateInfo]-gps.ubx Contains raw data collected by GPS/GNSS F9P regarding the data 

collection process that was started at timestamp denoted by 

[DateInfo].  
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Filename Description 

[DateInfo]-ins.txt Contains trajectory information obtained by INS/IMU regarding the 

data collection process that was started at timestamp denoted by 

[DateInfo]. Specifically, it contains measurements obtained by MTi-7. 

Data are logged in WGS84. 

Table 2: Project files containing actual on-site data. 

 

Figure 15: Example data contained in a MOBILO project folder. 

4 User Manual of the SharpLabelImage Application 
SharpLabelImage is a graphical image data labelling and annotation tool using object 

bounding boxes to tag and identify specific portions of an image.For each image in the 

dataset processed by the SharpLabelImage tool, a single XML file is produced and exported, 

containing the annotations inthe Pascal Visual Object Classes (VOC) format. 

The SharpLabelImage application is an extension of the LabelImg program written in Python 

3. While both programs offer similar functions and annotation tools, SharpLabelImage 

imports images, not only as files from the local system as LabelImg does, but is also able to 

capture sizable screenshots from computer monitors and transfer them in the application 

for annotation. 

Apart from importing single images, the user can import datasets of PASCAL VOC xml files 

and their accompanying images for further manipulation of their objects. These datasets 

could have either being produced from SharpLabelImage or from another similar data 

labeling program. 

4.1 Images 

Images are introduced in the design area of the program by using the capturing screen shot 

tool or by loading them directly from the file system. The only supported image format of 

the application is JPG format. 



 

 

 

 

   
ENTERPISES – 0916/0055 / WP8 / User Manual of the Prototype. (Deliverable [D19]) Page | 22 

4.1.1 Application Folders 

SharpLabelImage requires user to define two folders from their local system. The captured 

image folder for storing and loading images and their PASCAL VOC xml and the sample image 

folder for saving sample thumbnails for each annotation taken while using the program.  

These folders can be specified by left clicking the corresponding optionsfrom the Design 

Area Action(Figure 16) 

4.1.2 Capture a screen shot 

To capture a screen shot, click on Capture Screen Shot button (Figure 16- A). This will 

activate the snipping rectangle area (Figure 17) which can be positioned by clicking with the 

left mouse button and dragging it to the desired portion of screen. Τοresize the captured 

rectangle is done by clicking and dragging its borders. 

Press the Capture button to transfer the snippet on the Design Area or press the Esc button 

to cancel the procedure and close the snipping tool. 

4.1.3 Loading images 

From the Action menu left click the Load Image option. A file browser dialog will open from 

where a JPG image can be selected for loading. If the image is accompanied by a PASCAL 

VOC xml with the same name, then the label classes contained in the xml will also be loaded 

in the design area. 

4.1.4 Importing image folder 

To import an image folder with annotations, from the Action menu left click the Import 

Images options. A folder browser dialog will open from where the image folder can be 

selected. 

If images have been annotated at another file system, then the image file paths contained in 

the PASCAL VOC xml must change to the local file path system. The program will replace the 

origin file paths with the file paths of the current folder in which the images and their 

annotations are located. Any label found in the object attribute of the xml file will be 

imported in the application and a sample thumbnail will automatically be created. 

4.1.5 Navigating the image folder 

To navigate the image folder, use the directional arrows (Figure 16- C), by left clicking. The 

images are sorted based on their natural alphanumeric order, beginning with numbers, and 

then followed by any letter part the image name may contain. 
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Figure 16: Design area 

 

Figure 17: Select screenshot area 

4.2 Bounding box design and annotation 

4.2.1 Drawing a bounding box 

To draw a tag left click the Draw Tag button (Figure 16- B), the cursor will change into a 

crosshair which by left clicking and dragging will form a bounding box. By releasing the left 

mouse button, the rectangle will be placed on screen and the Labeling dialog will open for 

inserting the name of the annotation. 

To resize a rectangle on screen, place the cursor at any one of the bounding box borders. 

After the cursor changes, left click and draw to resize. 

4.2.2 Labeling the annotation 

The Labeling dialog (Figure 18) is used to assign a class name to the drawn bounding box. 

Type a new label class name in the text box (Figure 18- A) or select a name from the list of 

previously inserted labels (Figure 18- B). The label names inserted are being validated for 

uniqueness and for containing illegal path characters since their names are used as folder 

and file paths. 

The right part of the form contains two thumbnails. The uppermost is the tagged portion of 

the image (Figure 18- C) and the second is a sample image of the selected label class name 

used for validation and comparison (Figure 18- E). If the currently selected thumbnail is 

evaluated by the user to be more representative for the selected than the sample it can 

replace it by left clicking the Set as sample button (Figure 18- D). 

4.2.3 Renaming and deletion of annotation’s bounding box 

Renaming the label of an already drawn tag is done by right clicking inside the bounding box 

and by selecting the Rename option from the popup menu (Figure 16- G). 

To delete a tag from the design area right click inside the bounding box and select the Delete 

option from the popup menu. Confirm deletion by pressing OK to the confirmation dialog. 

To manually save the changes made to the annotations left click the Save option from the 

Action menu. 
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4.3 Editing Labels 

The Edit Label form (Figure 19) offers a detailed report of all the labels used by the program, 

the snapshots taken and provides the user with the ability to delete or rename a label from 

all images. To open the form left click the Edit option from the Action menu. 

4.3.1 Report Table 

The table (Figure 19- A) provides information about the labels found in the PASCAL VOC xml. 

 Label: the name of the label in alphabetical order. 

 Count: the number of times the label has been used in the annotated images. 

 Sample: a sample thumbnail image corresponding to the label. 

By left clicking a row of the table a label is selected and the image information where 

this label has been used are loaded in the right-hand side Annotation Information table. 

 

Figure 18: Label dialog 

Figure 19: Edit labels 

4.3.2 Annotation Information Table (Figure 19- B) 

 Image Name: the image name which the label annotates. 

 Snapshot: the part of the image annotated. 

4.3.3 Renaming and Deleting 

To rename a label left click the row of the Report table you wish to rename and then left 

click the Rename Label button (Figure 19- C). An input text box will open for inserting the 

new label name. Because this action will replace the label from all PASCAL VOC xml in which 

it is found extra confirmation is required by the user. 

To delete a label left click the row of the Report table you wish to delete and then left click 

the Delete Label button (Figure 19 - D). Confirm the choice from the confirmation dialog. 

4.4 Application Shortcuts 

 Ctrl + S, save changes 

 Ctrl + L, load image 
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 Ctrl + N, capture screen shot 

 Ctrl + D, drawing new annotation 

 Ctrl + E, open Edit Label form 

 Left arrow, load previous image 

 Right arrow, load next image 

5 User Manual of the Mobilo Data Processing Application 
MOBILO Mobile Surveyor is a low-cost mobile mapping system. It utilizes various sensors like 

GNSS/INS and machine vision cameras for data acquisition. The system captures stereopair 

images as well as the trajectory of the vehicle and since the system is calibrated, allows the 

user to extract various 3D information. The processing of the acquired data is very simple 

and is done via a tool developed as part of Mobilo. This document aims to explain how the 

data acquired from MobiloGrabber are processed.  

 

Figure 20 : The general user interface. 

5.1 The General User Interface 

Figure 20 shows the general user interface of the software. 

L. From file tab we can access various functionalities of the software such as open or 

save project, save frame, and export lines and points as shapefiles. 

M. From the Project tab, the 2 main functionalities that the user can access. The 1st is 

Point Attribute Editor, where the properties of various elements such as points and 

lines can be edited. The 2nd main functionality is the Heading calibration. Further 

explanation will follow.  

N. The user can select the basemap that will be shown on the left as is shown in Figure 

1. 

O. The user can jump into specific frames. 

A B C 

D 

E 
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P. The indicator here shows if the GPS position of the frame is fixed (Big Green Circle) 

or float (Smaller Green Circle inside a Yellow Ring). 

5.2 Open / Start a Project 

To start a new project, we need to set up a directory first. Some of the essential files that 

this directory must contain are the frames acquired, fix positions of the carrier, ring 

calibration etc. Once the directory is set up, from the File tab we select Open project and 

then we chose the directory we have set up. The project then is loaded, and we can start 

with the data processing. The directory that forms the project contains all files gathered 

from the data collection software (section 3.3), additionally to the ones displayed in the 

following tables. 

 Files depended on the calibration of the MOBILO system used for data collection 

(Table 3). These files should be manually copied to the project folder for the 

software to work properly. 

 Filles containing collected by user data (Table 4). 

 Files containing auxiliary project data (Table 5). 

Filename Description 

calibbaseins.txt Contains information about the INS/IMU collected data during the initial 

resection calculation for boresight misalignment correction 

calibbasephoto.ext Contains information about the exterior orientation of the left camera 

calculated by the initial resection for boresight misalignment correction 

calibGPSPositions.txt Contains information about the pre-calibrated GPS positions over the 

MOBILO System, and their offsets regarding the imaging sub-system’s 

reference system, with its origin on left camera 

ring.ring Contains calibration information regarding the stereo rig formed between 

the left and right cameras. 

Table 3: Project Files depended on the MOBILO calibration. 

Filename Description 

measures.pnt Contains information about point measurements, types, feature 

bounding boxes and other attribute data collected by the user with 

the MOBILO desktop application. 

user_attributes.json Contains attributes and metadata definitions designed by Custom 

Attributes UI interface and their corresponding values as  inserted by 

user through the datagridview components of the Mobilo main form. 

lines.pnt Contains information about line measurements collected by the user 

with the MOBILO desktop application. 

Featuretype.feat Contains information about the feature types recognized by the user 

with the MOBILO desktop application. 

Table 4: Project files containing collected data.  
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Filename Description 

Project.prj File containing info about the coordinate system to be used in 

project. File is in ASCII form and contains one line with the name of 

the projection system used. The file should be created manually. 

backgrounds.txt File containing reference to external maps (raster / vector) used as 

background during the data digitization process. File is created and 

managed by the application.  

Table 5: Project files containing auxiliary data.  

5.3 Add Tiles Background 

From the File tab the user can select Web Tiles Background. Here the user can import a 

basemap taken from the web. As shown in Figure 21 the user can select the Add Template 

tab and then import a name as well as a URL link in order for the software to store the 

various basemaps. Certain basemaps can be obtained from the following link  

https://www.spatialbias.com/2018/02/qgis-3.0-xyz-tile-layers/. 

 

Figure 21 : Adding a new Web Tile Basemap in the database. 

5.4 Heading calibration: Calculating the correction of moving heading vector 

To determine the correction angle δheading that is added to the vehicle’s movement heading 

so as to estimate the MOBILO system’s actual heading, the existence of an actual linear 

object that is visible from multiple frames on the imaging subsystem is assumed (Figure 22). 

This is a rather valid assumption since this kind of objects are usually visible in road images 

obtained by a moving vehicle, e.g., road fringes, linear delineations etc. 
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Figure 22 : Determining points’ positions that lie on a straight line, before adding δheading to the 

MOBILO’s system heading (Top). Points’ positions that lie on a straight line, after adding 

δheading to the MOBILO’s system heading (Bottom). 

Figure 23 shows how the user can add a linear object that is visible from multiple frames. 

When selecting Project and then Heading calibration, a window showing the frames is 

opened. From there the user adds 2 – 3 points in a line in this case on the side of the 

pavement. These points are added In at least 3 frame pairs at the exact same positions. After 

that the user presses Calibrate, and the heading is calibrated. The example shown below 

gives an error of 2 cm after applying the calibration. 

 

Figure 23 :Adding Heading calibration points 
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5.5 Points, lines, polylines, and general measurements 

From the main window, the user by right clicking on the right or left frame (Figure 5), can 

either add points, lines, polylines or take distance measurements. The attributes of the 

points added are displayed in the attribute table below the frame viewer. 

 

Figure 24 : The user can add 3D spatial elements by right clicking on either frame 

 

Figure 25 : Points, lines and polylines measured in a frame pair 
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Figure 25 displays elements measured on the frames. All the points and lines in this example 

were measured on the left frame and are reprojected in the right frame through matching 

algorithms.  

 

Figure 26 : Distance measurement displayed on both left and right frames. The measurement 

is given in meters. 

Figure 26 displays a raw distance measurement taken on the left image and simultaneously 

displayed on the right frame. 

5.6 Point Attribute Additions 

As mentioned previously, from the point attribute editor, the user can add and edit 

attributes related points. An example to it is the addition of height information regarding 

trees. To be more elaborate, let’s take the scenario of measuring trees as points. The 

measurement will show attributes such as point name, XY image coordinates on both 

images, XYZ of 3D coordinates, object distance from the system and Left/Right image XY 

errors. What is not measured automatically as an attribute is the tree height. To compensate 

for that we can follow a specific procedure: 

 From the Project tab we select Point Attribute Editor. 

 We can add a new column and introduce the name and the type of the attribute. 

 We select ok and the columns are added into the attribute table below the frame 

viewer. 

 Following that we can then measure a tree as a point. 

 To add its height, we then proceed by measuring the distance from the bottom to 

the top of the tree in the frame and then manually import the height into the 

attribute table. 

Figure 27 shows the Point Attribute Editor where Figure 28 shows the measurement of a 

tree’s height and the manual documentation in the attribute table. 
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Figure 27 : Point Attribute Editor with the attributes Height and Length already created 

 

 

Figure 28 : Height measurement of a tree and a sign. 
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Although this procedure is not accurate in case of trees it gives an indication of the height. In 

the case of signs or lamps the measurements are significantly more accurate since the 

measurement of the height is straightforward starting from the base and measuring to the 

top. Another use of this feature that is essential is the measurement of street widths or the 

length of certain segments. 

5.7 Export measurements 

As mentioned above from File tab we can export lines or points (Figure 29) as shapefiles and 

then import them in any GIS software for further analysis. 

 

 

Figure 29 : Export Points or Lines as Shapefiles. 
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